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Legal Disclaimer
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1 Intermodal Rail Freight: Test Case

This document provides steps for testing the Intermodal Rail Freight scenario in SAP Transportation
Management (SAP TM).

In this scenario, a 20-foot container is handed to Continental Rail by the shipper Star Line at the container
terminal in Halterm in Halifax, NS. The container, which contains dangerous goods, is transported on a
scheduled train to Toronto by Continental Rail as per the order placed by the customer. The order also states
that the interchange to Burlington is to take place in the yard in Toronto, ON.

The container continues its journey to Oklahoma City, crossing the U.S. border in Detroit, MI. Ocean Bond is
responsible for transporting the container through the United States. The final destination of the container is
Houston, TX. Itis transported to Houston on a scheduled train operated by Burlington. In Houston, the
container is picked up at the yard by the consignee Hendricks Platforms Inc.

BURL BURL
Yard, Yard, CNYard, CNYard, Halterm,

Houston, TX Chicago, IL Chicago, iL Toronto, ON Halifax, NS

L TP S

s
| ¥ re
(A TSTLTY

CErpvsap .
0 = Mrede i m:

United States

Consignee: On- | On-Carr: Main

L ke < o Main Carriage: Shipper:
Henricks Carr: Joe’s Carr: e e
Platforms BURL | Trucking | CN SontnenclBail Stanline

Intermodal Rail Freight (1)

As an alternative, the container can be routed via Chicago, IL. Since congestion on the ordered, default route is
heavy, the container can be transported along the actual route via Chicago.

Intermodal Rail Freight: Test Case
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Continental Rail manages the transport from Toronto, ON to Chicago Heights Yard, and arranges for the
container to be subsequently moved for interchange to Burlington at Chicago IM EX Yard. For the cross-town
transport from Chicago Heights to Chicago IM EX, Continental Rail orders a truck subcontracted to Joe's
Trucking. The container is unloaded from the railcar and loaded onto the truck. Once transported, it is
unloaded from the truck in Chicago IM EX and loaded onto a railcar. It then continues its journey to its final
destination in Houston, TX. In Houston, the container is picked up at the yard by the consignee Hendricks
Platforms Inc.

BURL Yard, BURL Yard, CN Yard, Halterm,
Houston, TX Oklahoma, OK Toronto, ON Halifax, NS
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Intermodal Rail Freight (2)

Charges are invoiced based on the ordered route and rule 11. Continental Rail and Burlington each send an
invoice to Star Line for their section of the journey. The charges on each of the invoices include the respective
terminal handling at the source and destination locations.

In addition to the charges for transport and supplemental services, there may be costs incurred during
execution. These event-driven charges will added to the invoices as supplemental charges.

In this scenario, you assume the role of Continental Rail, which is running the SAP Transportation Management
system that you are in the process of setting up. All of the settings and data that are referred to as “internal” in
the following document therefore refer to Continental Rail.

Intermodal Rail Freight: Test Case
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2 Prerequisites

Before you begin this test case, you must complete the following tasks:

e Configure your user data (see User-Specific Customizing [page 6]).
e Set up your master data and organizational data (see Master Data and Organizational Data [page 6]).
e Configure your roles (see Roles [page 9]).

2.1 User-Specific Customizing

SAP Event Management Setup

Ensure that you setup your user according to the Assigning User to Web Transactions details in the Integration
of SAP Event Management guide. You can access the guide in SAP Solution Manager by choosing |+ Solutions/
Applications » SAP Transportation Management » Configuration Structures ¥ Basic Settings for SAP TM

<release> » Integration of SAP Event Management

Invoice Integration

Ensure that your user profile contains the parameter TM INVOICE CLERK (with aninitial value).

2.2 Master Data and Organizational Data

The Configuration Guide for Intermodal Rail Freight provides all of the required master data and organizational
data. For more information, see the following table:

Use the following master data in the process steps described in this document:

Master and Organizational Data Value Details

Company Code 3000 Only in SAP ERP
Sales Organization 3000 Only in SAP ERP
Purchasing Organization 3000 Only in SAP ERP

Intermodal Rail Freight: Test Case
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Master and Organizational Data Value Details
Business Partner RF-CR-01 Joe's Trucking
RF-CR-CN Continental Rail
RF-CR-BURL Burlington Railway
RF-CU-01 Star Line Canada Inc (Customer)
RF-CU-02 Burlington Railway (Customer)
Means of Transport RF-SHORT Feeder Locomotive Production
RF-SHORT-E Feeder Locomotive Interline
RF-TRAIN Scheduled Train Production
RF-TRAIN-E Scheduled Train Interline
RF-TRUCK Truck MTr
RF-TRUCK-S Scheduled Truck MTr
RF-RAILCAR Railcar
Equipment Group (Vehicle) A Equipped box cars
B Unequipped box cars
C Covered hopper cars
E Equipped gondola
F Flatcar
G Unequipped gondola
H Unequipped Hopper
J Gondola car
K Equipped hopper cars
L Special type cars
LocC Locomotive
M M-O-W, Scale, Passenger, Caboose, and
En
P Conventional intermodal cars

Intermodal Rail Freight: Test Case
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Master and Organizational Data Value Details
Q Lighter weight, Low-profile intermodal
R Refrigerator cars
S Stack car
T Tank cars
Equipment Type (Vehicle) FO77 Flat Car - COFC/TOFC
S615 Double Stack Car (FC)

Resources

RF-TRUCK-01

Truck 01 (Multi Res.)

ATSF-291000

Flat Car - COFC/TOFC /ATSF-291000

ATSF-291001

Flat Car - COFC/TOFC /ATSF-291001

ATSF-291002

Flat Car - COFC/TOFC /ATSF-291002

ATSF-291003

Flat Car - COFC/TOFC /ATSF-291003

ATSF-291004

Flat Car - COFC/TOFC /ATSF-291004

ATSF-291005

Flat Car - COFC/TOFC /ATSF-291005

Company Organization RF-COMP-CA Railway Company Code CA
Sales Organization RF-SORG-1 Railway Sales Organization CA
Purchasing Organization RF-PORG-1 Railway Purchasing Organization CA
Execution Organization RF_EORG 01 Railway Execution Organization CA
Locations RF 12605 Halterm Halifax, NS
RF 41978 Toronto Cargoflo, ON
RF 55989 Chicago Heights Yard, IL
RF 66001 Chicago IMEX, IL
RF 626200 Oklahoma City, OK
RF_35100 Houston, TX
CURF-CU-01@Q63501 Customer Star Line Canada Inc
CURF-CU-02@Q63501 Customer Hendricks Sealants Inc
Intermodal Rail Freight: Test Case
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Master and Organizational Data

Value

Details

Schedules

RF 12605 > RF_41978

Scheduled train CN 100 from Halifax,
NS to Toronto Cargoflo, ON

RF 41978 > RF_55989

Scheduled train CN 120 from Toronto
Cargoflo, ON to Chicago Heights Yard,
IL

RF 66001 > RF 35100

Scheduled train BN CHHO from Chi-
cago IM EX, IL to Houston, TX

RF 41978 > RF_ 626200

Scheduled train BN TOOC from Toronto
Cargoflo, ON to Oklahoma City, OK

RF 626200 > RF_35100

Scheduled train BN OCHO from Okla-
homa City, OK to Houston, TX

RF 55989 > RF 66001

Cross-town truck schedule in Chicago

Transportation Lane

RF 55989 > RF 66001

Chicago Heights Yard > Chicago IM EX

Service Product Catalog

RF_INTERMODAL S001

Rail Intermodal services for Door-to-
Door and Ramp-to-Ramp

2.3 Roles

You must assign the following roles to the users who are to test this scenario. The roles are required only if you
work in SAP NetWeaver Business Client (NWBC); if you use the standard SAP GUI, the roles are not necessary.

Roles in SAP Transportation Management

Business Role

Technical Name

Transportation Planner

/SCMTMS/PLANNER

Carrier Settlement Specialist

/SCMTMS/CARRIER SETTLEMENT SP

Process Administrator

/SCMTMS/PROCESS ADMINISTRATOR

Transportation Manager

/SCMTMS/TRANSPORTATION MANAGER

Carrier Internet User

/SCMTMS/SERVICE PROVIDER

Intermodal Rail Freight: Test Case
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Business Role Technical Name

Display /SCMTMS/DISPLAY

Roles in SAP Event Management

Business Role Technical Name Comment

SAP Event Management User /SAPTRX/SAP_EM USER Required to access Web transactions in
SAP Event Management

Roles in SAP ERP

Business Role Technical Name Comment

Process Purchase Orders SAP MM PUR PURCHASEORDER None

Online Invoice Verification SAP MM IV CLERK ONLINE Required to enter and verify carrier in-
voices

Automatic Settlements SAP MM IV CLERK AUTO Required to execute evaluated receipt

settlements

Intermodal Rail Freight: Test Case
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3 Process Overview Table

The following table provides an overview of the processes involved in the Intermodal Rail Freight test case:

Process Step

Business Role

Transaction Code

Expected Results

Create Forwarding Order En-
try

Customer Service Agent

NWBC

Forwarding order is created.

Define Actual Route — Trans-
portation Proposals

Customer Service Agent

NWBC

Actual route is defined and
stages are generated.

Check the Applied Charges

Customer Service Agent

NWBC

Charges are calculated based
on the ordered route.

Assign Freight Unit to Railcar

Transportation Planner

NWBC

(Planning Cockpit)

Freight units are assigned to
railcars.

Create Freight Order from
Schedule Departure

Transportation Planner

NWBC

(Planning Cockpit)

Freight order is created with
assigned voyage/trip.

Assign Railcar to Freight Or-
der

Transportation Planner

NWBC

(Planning Cockpit)

Railcars are assigned to
freight order.

Create Freight Order for Road
and Assign Freight Unit

Transportation Planner

NWBC

(Planning Cockpit)

Road freight order is created
and freight unit assigned.

Execute and Monitor Stages

Transportation Planner

NWBC

Freight orders are executed
and monitored.

Generate and Send Invoice to
Customer

Customer Service Agent

NWBC

Forwarding settlement docu-
ment is created and transfer-
red.

Billing document is created
in SAP ERP.

TM: Settling Freight Orders

Transportation Planner

NWBC

MIRO

Freight settlement document
is created and transferred.

Service purchase order and
entry sheet are created.

Intermodal Rail Freight: Test Case
Process Overview Table
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Process Step

Business Role Transaction Code

Expected Results

Verifying Logistics Invoices

Online

Carrier Settlement Specialist  MIRO
MRBR

MR8M

Invoice document for the
service purchase order is
created.

12
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4 Process Steps

The test case for Intermodal Rail Freight requires the following processes:

e Manage Forwarding Orders [page 13]
® Plan Rail Freight [page 17]

® [Execute Rail Freight [page 21]

e Forwarding Settlement [page 24]

® Manage Freight Settlement [page 27]

4.1 Manage Forwarding Orders

e (Creating Forwarding Order [page 13]
e Defining Actual Route and Transportation Proposals [page 16]
® (Checking Applied Charges [page 17]

4.1.1 Creating Forwarding Order

Context

Continental Rail receives an order from Star Line for the transport of one container of dangerous goods from
Halifax, NS to Houston, TX.

The customer service agent checks the order to make sure that it is complete. Based on the available customer
agreements, an appropriate service can be chosen where required.

Once the order has been saved, it is sent to Burlington for validation and confirmation.

Procedure

1. Asacustomer service agent in SAP NetWeaver Business Client (NWBC), choose |j¢ Forwarding Order
Management » Forwarding Order » Create Forwarding Order
2. Enter forwarding order type RFOI.

3. Deselect the Template checkbox.

Intermodal Rail Freight: Test Case
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4. Choose Continue.

5. Onthe General Data tab page, enter the following data at header level:

Field Value

Sales Organization RF-SORG-1
Transportation Mode 02 (Rail)
Traffic Direction 1 (Export)

Shipping Type

30 (Intermodal Rail)

Movement Type

RR (Rail Ramp to Ramp)

Forwarding Agreement RF_STARLN 001
Item 200
Service Product IRR S001

In the ltems table, choose the ||+ Insert » Container

datain the table:

pushbutton combination and enter the following

Field Value

Item Type CN

Container MSKU6011672
Equipment Group CN

Equipment Type 20G0

Quantity 1 PC

Gross Weight 2,570 KG

the item details.

Commodity Code Type

7. Select the row containing your container and enter the following data on the Commodity Codes tab page of

Commodity Code

ST

2819604 (ALUMINUM PHOSPHIDE)

In the items table, choose the |» Insert » Package

PUBLIC

pushbutton combination and enter the following data:
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Field Value

Item Type PKG

Pieces 4 PAL
Gross Weight 8,000 KG

9. Intheitems table, choose the ||» Insert » Product A pushbutton combination and enter the following data:

Field Value

Product 2819604 (ALUMINUM PHOSPHIDE)
Pieces 40 CAN

Gross Weight 8,000 KG

10. Press .

11. In the item details for the package, select the Dangerous Goods tab page.
12. Check that the dangerous goods checkbox has been selected for the package and if not, select it.
13. Save any changes you have made.

14. On the Business Partner tab page, enter the following data:

Field Value

Ordering Party RF-CU-01
Shipper RF-CU-01
Consignee RF-CU-02

15. On the Location and Dates/Times tab page, enter the following data at header level:

Field Value

Source Location RF-12605

Pick-Up Date <Today> + 1 day
Destination Location RF_35100

Delivery Date <Pick-up date> + 3 days

16. On the Charges tab page, enter the document currency CAD.

17. Save your entries.

Intermodal Rail Freight: Test Case
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4.1.2 Defining Actual Route and Transportation Proposals

Context

The commercial route as defined by the default route or as ordered by the customer may not always be the
exact route taken by the cargo. The system can propose an operational route based on the capacity of
scheduled and unscheduled vehicles, as well as constraints with regard to transportation, equipment, and
locations. The selected stages form the basis for operational planning.

Procedure

1. Asacustomer service agent in SAP NetWeaver Business Client (NWBC), choose ||¢ Forwarding Order
Management » Worklist » Overview Forwarding Order

2. Select the forwarding order you created and switch to edit mode.

3. Onthe Stages tab page, choose the ||» Actual Route ¥ Define Route i pushbutton combination to start the
transportation proposal

4. Onthe transportation proposal screen, choose the first result via Chicago.

5. Choose the Accept Routing pushbutton.

The following stages are added:

Transportation Source Source
Stage Stage Type Mode Location Location
1 03 (Main Carriage) 02 (Rail) RF 12605 RF 41978
2 03 (Main Carriage) 02 (Rail) RF 41978 RF 55989
3 03 (Main Carriage) 01 (Road) RF 55989 RF_ 66001
4 03 (Main Carriage) 02 (Rail) RF 66001 RF 35100

6. Save your entries

Intermodal Rail Freight: Test Case
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4.1.3 Checking Applied Charges

Context

When a forwarding order is saved in this scenario, the system automatically calculates the transportation
charges based on the ordered route. If this does not occur, check that the agreement party roles have been
defined on the Stages tab page of the actual route. If the roles are missing, enter the applicable role (ordering
party) for each stage.

In the step, you verify the charges that have been calculated along with the logical references and the parties
that are required to settle the charges.

Procedure

1. Asacustomer service agent in SAP NetWeaver Business Client (NWBC), choose |j¢ Forwarding Order
Management » Worklist » Overview Forwarding Order

Select your forwarding order and switch to edit mode.

On the Charges tab page, check the amount, assigned carrier, and payer on the charge items overview.
Select the charge items in turn and choose the Show/Hide Details pushbutton.

On the Overview tab page, verify the determination from the agreement.

Select the charge items in turn and choose the Show/Hide Details pushbutton.

N oo~ wN

On the Calculation Rules tab page, for example, check the rate hit from the determined rate table.

4.2 Plan Rail Freight

® Assigning Freight Unit to Railcar [page 18]

e Creating Rail Freight Orders from Schedule [page 19]
e Assigning Railcar to Rail Freight Order [page 20]

e (Creating Road Freight Order [page 21]

Intermodal Rail Freight: Test Case
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4.2.1 Assigning Freight Unit to Railcar

Prerequisites

You have created forwarding orders (see Creating Forwarding Order [page 13]).

Context

In this procedure, you assign the container represented by the “freight unit” planning object to the “railcar”
equipment. If you know the railcar ID, you can assign it at this point in time. If not, you can enter the railcar ID
when the container is loaded.

Procedure

1. Asatransportation planner in SAP NetWeaver Business Client (NWBC), choose || Planning » Planning

Transportation Cockpit

2. Onthe Transportation Cockpit: Profile and Layout Sets screen, choose || View » Selection Criteria

In the Search Criteria screen area of the Transportation Cockpit: Selection screen, enter the following values
(use the plusicon [+] where necessary to display additional fields):

Screen Area Field Operator Value
Freight Unit Stages Source Location contains RF_*
Destination Location contains RF_*
Pick-Up in Days (Past) is 5
Transportation Units Source Location contains RF_*
Destination Location contains RF_*
Freight Orders Source Location contains RF_*
Destination Location contains RF_*
Resources Means of Transport contains RF_*
Intermodal Rail Freight: Test Case
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Screen Area Field Operator Value

Schedules Schedules is <Schedule you

created earlier>

Schedules is <Schedule you

created earlier>

Schedules is <Schedule you

created earlier>

Settings Planning Profile is RF_AUTO_PLAN
Transportation Cockpit is RF_RAIL STEP 1 CAR
Layout

4. Inthe Save Search As: field at the bottom of the screen, enter a name of your choice.
Choose Continue.
Select the freight unit for the first stage.

Use drag and drop to assign your freight unit to a railcar resource.

© N o o

On the Transportation Unit — Trailer Hierarchy tab page, check that the freight unit has been coupled to a
railcar and that a railcar document has been created.

9. Save your entries.

4.2.2 Creating Rail Freight Orders from Schedule

Context
In this procedure, you create freight orders for each of the scheduled train departures that make up the route
from Halifax, NS to Houston, TX.

i Note

Make sure that the Template checkbox is selected in the Customizing activity Define Schedule Types.
Otherwise, the freight orders are actively linked to the schedules and it will not be possible to assign railcar
units subsequently.

Procedure

1. As atransportation planner in SAP NetWeaver Business Client (NWBC), choose [|# Planning » Planning

Transportation Cockpit

Intermodal Rail Freight: Test Case
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On the Transportation Cockpit: Profile and Layout Sets screen, choose || View » Selection Criteria

In the Saved Searches: dropdown box, choose the search that you defined earlier (see Assigning Freight
Unit to Railcar [page 18]).

Check that your selection criteria appear correctly.

Choose the Continue pushbutton.

In the screen area that contains the capacities, select the Schedules tab page.

Expand the node for the schedule for which you want to create a freight order.

From the list of departure times, select a departure and choose the Create Freight Document pushbutton.

As the document type, choose RFIN for your own rail freight orders (carrier CN) or RE'SC for interline
railroad carriers.

10. If required, you can select a vehicle such as a locomotive.
11. Choose OK.

12. Save your entries.

4.2.3 Assigning Railcar to Rail Freight Order

Prerequisites

You have created freight orders (see Creating Rail Freight Orders from Schedule [page 19]).

Context

In this procedure, you assign the railcar and its cargo to the train departures represented by the freight orders.

Procedure

N OO s WD

20

As a transportation planner in SAP NetWeaver Business Client (NWBC), choose |# Planning » Planning

Transportation Cockpit

On the Transportation Cockpit: Profile and Layout Sets screen, choose || View » Selection Criteria
From the Saved Searches: dropdown box, select the search that you defined earlier.

Choose the Continue pushbutton.

Select the railcar document that you create earlier.

Use drag and drop to assign the railcar document to a freight order.

On the Overview tab page, check that the railcar has been coupled to a freight order.

Intermodal Rail Freight: Test Case
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8. Save your entries.

4.2.4 Creating Road Freight Order

Context

In this procedure, you create a road freight order and assign a freight unit to it.

Procedure

1. Asatransportation planner in SAP NetWeaver Business Client (NWBC), choose |j» Planning » Planning

Transportation Cockpit

On the Transportation Cockpit: Profile and Layout Sets screen, choose ||» View ¥ Selection Criteria
In the Saved Searches: dropdown box, choose the search that you defined earlier.

Check that your selection criteria appear correctly.

Choose the Continue pushbutton.

In the screen area that contains the capacities, select the Vehicles tab page.

Expand the node for the schedule for which you want to create a freight order.

Assign freight unit stage 30 to vehicle RE_TRUCK using drag and drop.

Choose OK.

10. Save your entries.

11. Check that the freight order has been created.

© N OO AW

4.3 Execute Rail Freight

e Executing Freight Orders [page 22]
® Monitoring and Executing Freight from SAP Event Management [page 23]

Intermodal Rail Freight: Test Case
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4.3.1 Executing Freight Orders

Use

Based on the planned freight order data, the system creates expected milestones for loading the container at
the CN ramp, each of the junctions, and the final destination in Houston. These milestones enable you to
monitor and track the transportation.

The system generates the necessary tracking events to track the cargo. These events include items such as:

® | oading and unloading
® Departure and arrival at destination

The forwarder receives execution information through various communication channels and updates the
events in SAP Event Management to track the transportation status. In this way, containers and railcars are
tracked end-to-end from the origin ramp in Halifax to the destination ramp in Houston.

Procedure

1. Asacustomer service agent in SAP NetWeaver Business Client (NWBC), choose |j¢ Forwarding Order
Management » Forwarding Order » Edit Forwarding Order
2. Enter your forwarding order.

3. Onthe Document Flow tab page, select the number of the freight order that you created for the first stage
and open it by clicking the link.

4. Onthe General Data tab page, check that the departure date and the arrival date have been entered. If not,
enter them manually.

5. Check that the Purchasing Organization (RE_PORG_01) and the Planning and Execution Organization
(RF_EORG_01) have been entered. If not, enter them manually.

6. On the Equipment tab page, select the railcar and enter resource CN_7208 if this has not already been
done.

i Note

You can also change the status at this point by choosing ||» Set Status » Set to Ready for Transportation
Execution

7. Save and switch to edit mode.
8. Onthe Execution Information tab page, choose Insert Event.
9. Enter the following data:

Field Value
Event Departure
Actual Event Date <Planned pick-up date>

Intermodal Rail Freight: Test Case
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Field Value

Location RF_12605

10. Choose Report Event.
11. Choose Insert Event and enter the following data:

Field Value

Event Arrival at Destination
Actual Event Date <Planned pick-up date>
Location RF_41978

12. Choose Report Event.
13. Save and close.
14. On the Stages tab page of the forwarding order, check that the status for stage 1 has changed to Arrived.

Check

1. As acustomer service agent, choose the following menu path in SAP NetWeaver Business Client: ||» Freight
Order Management ¥ Freight Order ¥ Edit Freight Order

2. Select the freight order for the first stage.

3. Check the Charges tab page.

A basic rate should be displayed.

4. If no charges have been calculated, check the General Data tab page to see whether the purchasing
organization has been entered. If not, enter the corresponding forwarding house (the export station in
either Tokyo or Nagoya).

5. Choose Calculate Charges.

Repeat these steps for all your routed stages in the relevant freight orders until the freight units arrive in
Houston.

4.3.2 Monitoring and Executing Freight from SAP Event
Management

Context

When the container is delivered to the BNSF yard, the BNSF customer sends proof-of-delivery using the Web
front end of SAP Event Management. This completes the transportation process.

Intermodal Rail Freight: Test Case
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Procedure

1. Asacustomer service agent in SAP Event Management, choose || Event Management » Web Interface
Search
2. Select the tracking scenario Shipper — Freight Unit Visibility Process.

3. Select your forwarding order and post the proof of delivery.

4. As acustomer service agent in SAP Event Management, choose ||» Event Management » Web Interface
Search
5. Select the tracking scenario Resource Tracking -Visib. Process.

6. Select your equipment and check the expected dates and times.

4.4 Forwarding Settlement

Use

The transportation division has negotiated a freight agreement with the in-house customers, including the
sales division that triggered the transportation of the container. This freight agreement provides a framework
for the costs used by the transportation division to provide a service to the other divisions in the enterprise.
The transportation division is responsible for managing any market fluctuations that affect pricing, and acts as
an in-house division to improve consolidation within the enterprise. Service levels are based on fixed changes
that are incurred by the sales or purchasing organizations in the company. This enables sales and procurement
processes to be carried out based on budgets and reliable costs for the in-house divisions.

Penalties may be agreed in the event that commitments are not met during the transportation process. The
transportation charges calculated in the request therefore originate from the freight agreement, and can
contain additional charge elements (for example, services such as fumigation or repacking), which are not part
of the freight agreement between the transportation division and the shipping sales department.

Once transportation has been completed, the system creates a forwarding settlement document and transfers
it to SAP ERP.

Costs for outsourcing have to be transferred from SAP TM to SAP ERP on the basis of freight settlement
documents. MM-PUR verifies the invoice based on incoming documents and posts costs based on the
information on the service entry sheet for the service purchase orders of the carriers.

Activities

e Managing Forwarding Settlement [page 25]
e Transferring Forwarding Settlement Document to SAP ERP [page 25]

Intermodal Rail Freight: Test Case
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4.4.1 Managing Forwarding Settlement

Context

This procedure is optional. You can use it to create an invoice (forwarding settlement document) for the entire
shipment, which is then posted in SAP ERP and sent to the customer.

Procedure

1. Asacustomer service agent in SAP NetWeaver Business Client (NWBC), choose |j¢ Forwarding Order

Management » Forwarding Order » Edit Forwarding Order

2. Enter the number of the forwarding order that you created earlier and choose the Continue pushbutton.

3. Check that the agreement party role has been entered on the Stages tab page for all stages.

4. On the Charges tab page, choose the | Calculate Charges » Calculate Charges A pushbutton combination.
5. Save your changes and switch back to edit mode.

6. Choose |i# Follow Up » Create Forwarding Settlement Document

7. Select the radio button for ordering party RF-cU-01 and choose Select All for the settlement group.

8. Choose OK and save your forwarding settlement document.

Results

On the Charges tab page, the invoicing status has changed to 04 — Completely Invoiced.

4.4.2 Transferring Forwarding Settlement Document to SAP
ERP

Context

This procedure is optional.

In SAP Transportation Management, you generate forwarding settlement documents that are “pre-invoices”
containing all of the data that is relevant for invoicing.

Intermodal Rail Freight: Test Case
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You trigger the creation of the final customer invoices and final customer credit and debit notes from the SAP
TM system. The forwarding settlement document in SAP TM is sent through Xl to the SAP ERP system and
converted into regular invoices, credit notes, or debit notes in SAP ERP in accordance with the SAP TM add-on
logic. The customer invoices are then available in the SAP ERP system.

After you have created the credit or debit note in SAP ERP, the financial document is created automatically. The
FI document is the basis for further processing of the billing document in accounting and controlling.
Depending on the system settings, you can also create documents for the general ledger, profit center,
profitability analysis, and cost accounting.

Procedure

1. In SAP NetWeaver Business Client, choose | ¢ Forwarding Settlement ¥ Worklist » Overview Forwarding
Settlement Documents

2. Select the forwarding settlement document created for customer RF-CU-01 from the input help () and
choose Continue.

3. Choose Save and Transfer.

4. Check the status of the forwarding settlement document.

If the consistency status of the forwarding settlement document is Consistent, it should change from
Ready for Invoicing to Transferred for Invoicing.

5. Goto the Document Flow tab page.

Make a note of the updated SD billing document number.

6. Check the status of forwarding settlement document.

Once the billing document number has been updated, the status should change from Transferred for
Invoicing to Invoiced.

Check the billing document in SAP ERP using transaction vE03.
8. Open the SD billing document from the document flow of the forwarding settlement document.
9. Go to the document header and check the following:

o  The quantities in the billing document are the same as the quantities in the forwarding settlement
document.

o The net value (amount) in the billing document is the same as the net amount in the forwarding
settlement document.

o The date in the billing document is the same as the date in the forwarding settlement document.

o The line items in the billing document are the same as the line items in the forwarding settlement
document.

o The payment terms in the billing document are the same as the payment terms in the forwarding
settlement document (if the payment terms are not sent from SAP TM to SAP ERP, the payment terms
in the billing document are the default payment terms from the customer or vendor master).

o The bill to parties in the billing document are the same as the bill to parties in the forwarding
settlement document.
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Results

The forwarding settlement document for consignee RF-CU-01 is transferred to SAP ERP and a corresponding
SD billing document is created. This, in turn, updates the forwarding settlement document in SAP TM. You can
also check the billing document SAP ERP using transaction vF03.

4.5 Manage Freight Settlement

Use

You can use this business activity to evaluate, calculate, and distribute the transportation charges for the
business partners involved in the supply (that is, the suppliers). The transportation charge calculation is based
on the outgoing freight document (freight order or freight booking). The business partners involved are
supplying parties, such as the logistics service providers and carriers.

This business process enables the financial transactions for supplier invoicing. The outgoing freight documents
are rated according to charges that the transportation division and the subcontracted common carriers have
contractually agreed.

Once transportation is complete, the system creates a freight settlement document and transfers it to SAP
ERP. Based on this document, you post accruals in SAP ERP for expected supplier invoices in SAP MM.

You can verify your supplier's invoices against the accrued amounts or send the supplier a credit memo created
by a self-billing procedure (Evaluated Receipt Settlement — ERS).

In this scenario, all costs are settled directly from the carriers to the customer.

Activities

Billing [page 27]

4.5.1 Billing

Use

i Note

This procedure is optional.

In this procedure, transportation charges are transferred from SAP TM to SAP ERP using freight settlement
documents. In SAP ERP, the charges can be used to verify actual charges from the supplier’s invoices.
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Procedure

1. Asacustomer service agent in SAP NetWeaver Business Client (NWBC), choose ||+ Forwarding Order
Management » Forwarding Order » Edit Forwarding Order

2. Enter the number of the forwarding order that you created and choose the Continue pushbutton.

3. Gotothe Stages tab page.

4. Complete the steps below for all of your forwarding orders.

Update and Recalculate Charges

1. Select the number of your first stage freight order.

2. Onthe Charges tab page, check that charges have already been calculated. If not, choose Calculate
Charges.

Create Freight Settlement Document

1. Check that the invoicing status is Not Invoiced and that the charge calculation status is Calculated.
2. Save any changes you have made.

3. Switch to edit mode.
4,

Choose |jr Follow Up » Create Freight Settlement Document
Transfer Freight Settlement Document to SAP ERP

1. Inthe new window, choose Save and Transfer.
2. Note the freight settlement document number:
3. Choose Close.

Result

The Invoicing status of your freight orders has changed to Completely Invoiced.
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

o Links with the icon # : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
e The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
e SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
o Links with the icon & : You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such
links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.
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© 2018 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form
or for any purpose without the express permission of SAP SE or an SAP
affiliate company. The information contained herein may be changed
without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software vendors.
National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any
kind, and SAP or its affiliated companies shall not be liable for errors or
omissions with respect to the materials. The only warranties for SAP or
SAP affiliate company products and services are those that are set forth
in the express warranty statements accompanying such products and
services, if any. Nothing herein should be construed as constituting an
additional warranty.

SAP and other SAP products and services mentioned herein as well as
their respective logos are trademarks or registered trademarks of SAP
SE (or an SAP affiliate company) in Germany and other countries. All
other product and service names mentioned are the trademarks of their
respective companies.

Please see https://www.sap.com/about/legal/trademark.html for
additional trademark information and notices.

THE BEST RUN
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